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1. Introduction

EasyHDR is an image processing software that produces and tone maps High Dynamic Range
(HDR) images out of photo sequences taken with a digital camera. The program works on Windows XP,
Vista, 7, 8 (32 and 64-bit) and on Mac OS X 10.7 and above.

The basic idea of High Dynamic Range image processing is depicted on the graphic below.

The first step is to take a set of photographs of the same scene, at different exposure settings.
EasyHDR will produce a so called HDR image (radiance map) out of these photos. The radiance map is
nothing else than just an artificial photograph, but what makes it different is the dynamic range that it
covers. It contains all the detail that was acquired on any photo from the set. The only problem is that it
cannot  be  simply  displayed  on  a  computer  screen  as  the  dynamic  range  of  this  display  media  is
relatively very low. Therefore another step has to be done – tone mapping or in other words: dynamic
range compression. The tone mapping can utilize a global or local operator to achieve the compression.
The global operator can give most realistic results but if the dynamic range is very high it is simply not
able to give good looking output as the details and colors get washed out. Therefore the local operators
are used in addition. They allow much higher level of compression, because they operate on the local
level. The details in the image are amplified, while the overall dynamic range is shrunk. This gives a lot
of possibilities. You can either make the result look very dramatic, or just achieve better realism by
smartly using the local contrast boost.

The modern DSLR cameras are equipped with better and better CMOS or CCD sensors in sense
of signal to noise ratio. In many cases just a single photo may be good enough for tone mapping. It
means that it is not always necessary to take an image sequence, which may sometimes be difficult
because of moving subjects or long exposure time needed. Because of that easyHDR allows you to tone
map just a single photograph – JPEG or for best results: RAW.
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2. User interface

The user interface of easyHDR's main window consists out of two base parts: workspace (1) and
three-tab panel with tools and settings (2).  Additionally, when working in tone mapping mode a third
part appears (3). The panels are resizeable. They can also be folded completely to maximize the size of
the workspace. In order to change their width use the grip on the inner border.

EasyHDR user interface.

The top of the window is occupied by main menu (5) and the tool box (4). The latter contains some of
the most important options of the main menu. 

In the bottom there is  a status bar (6) which contains the main progress bar,  zoom control  for the
workspace and a label showing basic information about the image – dimensions and pixel value under
cursor. When color management is enabled, additionally there are also two buttons allowing fast access
to color profile options. Hover mouse cursor over them to see detailed information about color profiles
in use.
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 2.1. Workspace

In the workspace you can view the input photos, a HDR intermediate image and of course the
preview of tone mapping. What is visible depends on current step of operation, but it's also possible to
temporarily  switch to other views using “Photo before  processing” option.  It  gives an easy way to
compare  the  result  with  inputs.  It  also  provides a way to  examine the input  images  after  they are
preprocessed (aligned and corrected for chromatic aberration).

Photo before processing.

The use of workspace is intuitive. Zooming can be done with mouse wheel, to pan around just press the
left or right mouse button. When in cropping mode, double click inside of the crop area to accept, or
away to cancel.

There is a possibility to change the background color of workspace. Just press the button in the lower,
left corner. 

The images are always shown at full resolution, the detail seen depends only on zoom factor. The view
is anti aliased for best viewing quality. When tone mapping, processed is only the visible part of the
image, which ensures the best performance.  It's possible to tune the performance of the program by
toggling live anti-aliasing and live tone mapping. For these settings please see the Program Options
section.

 2.2. Main tabbed panel

There are three tabs that correspond to three steps of processing. Switching between those tabs
changes the mode of operation. The steps are the following:

1. loading, pre-processing and HDR generation,

2. tone mapping,

3. post-processing (optional).

In the first step it's possible to create new project, add and remove HDR sequence photos, configure the
EV values and finally, after optional pre-processing of the input photos, generate the HDR image. When
HDR image is generated and some precalculations are made, it's possible to work at the second step –
the tone mapping. At any time you can go back and i.e. regenerate HDR image with different options, or
realign input photos, etc. When you are happy with the parameters you can just save the result to file, or
proceed to the last step – the post-processing.  In both cases the whole image is first  processed at full
resolution (previously only the visible area was processed). It's still possible to go back to tone mapping
or even to the first step. In that case however the applied filtering is lost.
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Three-step approach to HDR processing.

For more details about each step please refer to the corresponding part of this document.
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 2.3. Additional tone mapping options panel

This panel appears only when you are working at the tone mapping step.  It contains two tabs:
Preset and History.

The preset tab allows not only simple selection of built-in
presets, but also defining and using user presets. Preset selection is
done by left  mouse clicking  on  a  thumbnail.  You can  edit  the
name of user presets by just clicking on it. Right click on a user
preset  to  get  more options:  delete, replace  and  move to  group.
More  information  about  presets  can  be  found  further  in  this
document.

The  history tab gives undo / redo functionality. All the
tone  mapping  settings  changes  are  stored  here  with  a  short,
descriptive  text.  You  can  easily  revert  the  parameter  changes,
while still having the ability to change your mind. 

3. HDR radiance map generation

 3.1. Taking the photographs

The dynamic range (or the luminosity range) is the ratio between the brightest and the darkest
part of the photographed scene. The human vision can accommodate (in long term) the dynamic range
of 1014 : 1 (from starlight to bright objects in full sunlight). The light accommodation is achieved mostly
by chemical means, the iris is simply not as flexible. The human eye covers the dynamic range of about
100 000 :  1 at  one time, just the top dynamic range of most real-world scenes.  In comparison the
dynamic range of typical digital cameras is about 1000-4000 : 1 and in case of computer displays it is
even much worse. However, having the ability to cover a very wide dynamic range, the human brain is
not able to distinguish small changes in brightness and also human perception is logarithmic rather than
linear. Of course the digital camera and computer display design take advantage of that fact.

The camera chip (CCD or CMOS) responsivity is more or less linear. A 12-bit RAW image is
converted to an 8-bit per channel photo using a compression curve stored in the camera in a Look Up
Table (LUT). So the whole dynamic range that the camera can cover is compressed (fitted) into 8-bit
(0..255) values.
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EasyHDR allows you to create a photo that covers a much wider dynamic range than a single
image  taken  with  a  typical  digital  camera.  First  of  all  you  have  to  acquire  enough  luminosity
information from the photographed scene. You can do that by taking several photographs at different
exposure times so the whole dynamic range is covered. The brightest details have to be clearly visible in
the  shortest  exposure  and  the  darkest  should  be  visible  in  the  longest  exposure  image.  It  is
recommended to set exposure times such that the Exposure Value (EV) step between the images is
about  1  or  2  EV.  In  most  cases  3  images  will  be  sufficient.  In  order  to  take  the  image sequence
automatically with your digital camera, you can use the Auto Exposure Bracketing (AEB) option.

For best results, the images shouldn't be too misaligned and therefore should be taken with a
camera on a tripod. However for easyHDR there is no problem if the photos were taken hand-held,
because it has automatic as well as manual alignment tools built-in. Both are able to compensate even
for perspective misalignment.

 3.2.  Image sequence loading

In order to load the image sequence just click New and multi-select all of the photos from the
sequence that you want to be used. It is also possible to add more photos to the already loaded sequence
or to remove some of them without the need to start again. If you load only one photo you will be able
to enhance it with the tone mapping operators that are normally used with HDR data. This feature is
called "LDR enhancement" and simply allows enhancing single shots – most preferably single RAW
photos. EasyHDR will also load photos dragged and dropped on the main program window or photos
for which the paths are provided as run-time parameters (useful for plugging easyHDR as an external
editor for other image editing or management software).

EasyHDR loads JPEG photos as well as 8 and 16-bit TIFFs. It also features a built-in RAW
converter (using an external program:  DCRAW) that is capable of importing almost all of the RAW
photo formats by all digital camera vendors. It is also possible to load FITS file format, that is most
commonly used in astrophotography. EasyHDR supports additionally High Dynamic Range formats:
Radiance RGBE (*.hdr), OpenEXR (*.exr) and 96-bit TIFF.

 3.2.1. Loading RAW photos

EasyHDR provides a graphical interface to DCRAW in a form of a dialog window displayed
when a RAW image is being loaded. It allows control over several DCRAW options: output color space
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(if Color Management is enabled), white balance, median and wavelet noise filtering and finally special
highlight recovery mode, which is especially useful when processing single RAW photos.

Applying white balance correction and filtering noise at RAW decoding step is the best way to
achieve greatest possible correction level. It's because the operation is done on totally raw data. 

By default the camera-stored settings for white balance are used, but you can either manually modify
the multipliers (advanced) or pick a sample from preview image. The picked color is the targeted neutral
point – the multipliers are calculated automatically by DCRAW. 

In case of noise filtering, it's worth mentioning that median filter is useful for removing hot pixels, while
the wavelet filter smooths random noise. The “Recover highlights” option allows getting more detail in
the overexposed areas, but at the same time it may cause some color shift there. Therefore it's advised to
use it rather only in case of enhancing single RAW photos, when some more detail is really needed.

If  further  color  correction is  necessary  or you want  to  remove some more  noise,  easyHDR
allows these at later steps as well – advanced color adjustment is possible at the tone mapping level,
while more noise filtering can be done at pre-processing step.

RAW image loading – DCRAW options.

 3.3.  HDR generation

After loading the photo sequence,  a HDR generation window with processing options appears
automatically. If the EXIF data of the photos is correct and the calculated EV values for the photos are
good you are just a click away from generating a HDR image. Otherwise you can go back by closing the
dialog and edit the EV values. The EVs are vital for correct HDR generation. They are most important
for ghost removal, but auto alignment also requires them to be more or less correct.
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Editing the EV values for a 3-photo HDR photo sequence. 
The photos are automatically sorted by the EV values, from smallest to highest.

By default the EV values are calculated upon the exposure time, ISO and f-number found in the EXIF
headers. If the EXIF is incomplete easyHDR assumes the values by itself. In case of AEB sequences
taken automatically by the camera, it can sometimes happen that the stored, camera-targeted EV values
do not match with the calculated values. The user is warned about it and can react by selecting which
values to use.

You can experiment with HDR generation by disabling some of the already loaded input photos from
being used for the HDR. There is no need to remove the photos, just uncheck the checkbox next to the
name of the photo.

There are 3 algorithms available, that generate either a real HDR radiance map (True HDR) or a
pseudo-HDR image (Smart Merge and Image Stacking). 

HDR generation options.
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 3.3.1. Pre-processing

Before  generating  the  HDR image  it  is  possible  to  pre-process  the  input  photographs.  The
available options are: chromatic aberration correction and image alignment. After pre-processing, it is
possible  to  view  the  modified  photos  in  the  main  program  window  by  using  the  “Photo  before
processing” option.

 3.3.1.1. Chromatic aberration correction

Chromatic aberration is one of the optical defects of lenses. It occurs when the lens does not
focus all light wavelengths in one point, because of different refractive index for different wavelengths.
In the photo it appears as “fringes” of color around dark-bright boundaries. This effect gets stronger
towards the borders of the photo and typically is the lowest (or does not exist at all) in the center of the
image. Chromatic aberration effect can be very low in the most expensive achromatic lenses, however
there is a way to reduce this effect even if the photo was taken with typical amateur equipment.

In easyHDR there is a manual Chromatic Aberration Correction tool that allows you to repair
your photographs and to increase their quality. It  can be used right after the photos have been loaded,
but before they are aligned or used for generating a HDR image. 

Chromatic aberration correction tool.
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After starting the tool select one of the photos from the loaded sequence that will be used for
previewing. By default the middle exposed one is taken. Pan around close to the image borders and find
an area  with chromatic  aberration  defects  clearly visible.  Then,  try  to  reduce the defect  by setting
Magenta-cyan and  Blue-yellow scale factors. The Distortion correction setting may be useful if it's
hard to fix  the aberration with the two basic factors.  It  is  possible to move the central  point to an
arbitrary location by double clicking on the image. 

When you change the parameters the preview is  refreshed automatically. You can have a look at the
original input while panning the image.

After selecting the best parameters you can check whether they also work for other photos in the input
sequence. Then press “Apply” to process all the input photographs.

Because of the fact that chromatic aberration is a constant defect of the lens, it makes sense to
save and reuse the correction settings. In order to save a preset type its name in the edit field and press
“+” button. To delete, just select the preset from drop down list and press “-”. The presets can be also
used in the batch processing. 

It should be noted that chromatic aberration for zoom lenses is varying with focal length,  so a single
preset for a zoom lens is definitely not enough.

 3.3.1.2. Alignment

In order to get the best, sharp and fine detailed results, the photo sequence used to generate the
HDR radiance map should be taken with a camera on a tripod. Of course it is not always possible. Even
the fastest cameras, with exposure bracketing option enabled, still need quite much time to take the full
sequence.  The  slightest  move  of  a  hand  during  that  process  can  cause  the  acquired  photos  to  be
misaligned in respect to each other, which results in artifacts on a generated HDR image. The weirdest
artifacts may appear on a HDR created with “True-HDR” method with “Balanced” selectivity setting.
They are caused by invalid pixel luminosities – i.e. an area that should be darker on a shorter exposure
is in fact brighter, which confuses the algorithm.

Manual alignment 

EasyHDR has a built-in manual alignment tool that can be used to align the photos if it's needed.
The tool uses planar stretching method that is controlled (by the user) by manual placement of up to 4
pins for image pairs. One of the images, preselected by the user, is called “base”. All other photos (“to
align”) are aligned to the “base”. The user has to set the pins for each pair of the photos.
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Crop of a tone mapped HDR blended from 
misaligned photos.

After manual alignment.

Below  is  the procedure that  leads to  generation of a HDR radiance map from a misaligned
sequence of photographs is described:

● Load a sequence of photos into the program and click “Manual alignment” button in the “HDR
generation” window.

Photo to be aligned is loaded into the top-right box. The preview style was selected as 
“difference” to better show the misalignment.
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● Choose the base photo to which the remaining images shall be aligned. The base photo appears
in the top, left box. By default the middle exposed photo is automatically selected.

● Decide on the method of transformation (of course you can do it later as well, but please note
that the method is common for all photos that are transformed). Compensation for shift requires
setting of one pin pair. Shift and rotation needs 2 pin pairs. Perspective matching is achieved by
setting all the available, 4 pin pairs.

● Open one of the remaining photographs in the top, right box. This is the photo that will be
transformed by the program in order to be aligned to the base image.

● Set the pins, on the two loaded images (base and “photo to align”), so they point exactly at the
same object details of the photographed scene. It is a good practice to initially place the pins
close to the chosen scene features while the zoom is set to a small value and later fine tune the
placement at higher zoom. The pin centering option (see picture below) is useful while fine
tuning the positions. The view is automatically centered at the selected pin pair. 

The keyboard arrows can be used to fine tune the pin positions. Just double-click on the chosen
pin to enter the keyboard mode. While the right  Shift key is held, the pin jumps several times
faster. In order to exit the keyboard mode, press Enter, Space, Esc or double click on the image
away from a pin. 

Please note that the image is correctly transformed only after all the required pin pairs are
properly placed. You can disregard what is shown in the preview box until the last pin is
set and then use the preview while fine tuning.

● Repeat the operation described in the previous two points on every photo, that shall be aligned
to the base. Note that it is possible to set different pin positions for each image pair. 

● Click on the “Apply” button. The photos will be aligned and in the next step you will finally be
able to generate the HDR radiance map. 
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Four pins point at exactly the same picture features. The pins are set with sub-pixel accuracy.

The manual alignment tool can be also used in a semi-manual  way. Right after the window
appears it is possible to use the “Auto all” button to allow easyHDR place the pins automatically. The
user can check whether the automatic algorithm succeeded and if it's necessary, correct the pin positions
before applying the alignment. The “Auto” button, on the other hand, causes automatic pin placement
for just the currently selected image pair.

When compensating for more than just the shift please note that the pins should be well spread
over the photograph. The best case is when they are located near the corners. Placing them too close to
each other or setting 3 or 4 of them in one line will result in big alignment errors and therefore should be
avoided. A score value (0 to 100) is calculated by the program to help you set the pins correctly. 

Bad spread of the pins. Pins are
almost in one line.

Score = 14/100

Bad spread of the pins. Pins are too
close to each other.

Score = 13/100

Good spread of the pins.
Score = 61/100

In a HDR image sequence it might be hard to find the same details in both pictures (base and
“photo  to  align”)  due  to  the  difference  in  brightness.  If  the  detail  is  not  overexposed,  but  rather
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underexposed in the darker of the photos, you may manually alter gamma setting for the particular
image, in order to brighten (or darken) it. “Auto contrast” option may also be useful. It automatically
enhances contrast (not gamma) in the darker of the photos, to match it to the brighter one.

Automatic cropping option can be used to cut off the parts of the images that are invalid in one
or more of the aligned photos. Such invalid parts have bad influence on the tone mapping process when
local operator is used.

Automatic alignment 

The  automatic  alignment  feature  is  a  convenient  way  to  align  photos  without  any  user
intervention. It always tries to compensate for shift, rotation, scale and perspective. 

Tip: you can check whether the alignment succeeded before generating the HDR image (which is time
consuming). To do so just close the HDR generation window and use the “Photo before processing”
option.

Undoing the alignment

When the results of the alignment are not as good as anticipated (in case of automatic option)
and you'd like to try again manually, it is possible to undo the already done transformations. 

Saving the aligned photos 

When the alignment is done it is possible to save the transformed photos for future use: File →
Save aligned photos. The files are saved to a chosen directory with a prefix added to the file names.

 3.3.2. HDR image generation options

The HDR generation step is the moment when the preprocessed, input sequence of photos is
finally merged, in order to form a single image – the HDR radiance map. It is possible to choose one out
of three methods for HDR generation: True-HDR, Smart Merge & Image Stacking.

EasyHDR allows also tone mapping of a single LDR photo (i.e. a single RAW or JPEG). In such
a case, a HDR radiance map is not generated of course. Instead, the input image is prepared for being
tone mapped. In easyHDR it is called “LDR enhancement”.

The common post HDR generation / LDR enhancement option is  noise filtering. This feature
reduces the noise level in the already generated HDR image, before it undergoes tone mapping. This
approach ensures that the noise itself is not strengthened so much by the Local Contrast tone mapping
operator. It allows relatively stronger local contrast boost, while preserving good signal-to-noise ratio in
the final photograph.
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Single RAW image tone mapped with high strength of Local Contrast operator. Without applying noise 
filtering before the tone mapping (left hand picture) the noise level is very high. If the noise filtering is 

applied, the image is smooth while the fine details are preserved. In this example the noise filtering 
strength was set at: 6 and softness was 3.

When processing an image which is an already assembled, 360° panorama, the “360°” option
should be checked. In this case the tone mapping will be done as if the left  and right border were
connected  with  each  other.  Otherwise  they  wouldn't  match  when  virtual  tour  was  made  with  the
processed image.

 3.3.2.1. True HDR

The True HDR method generates a radiance map that closely represents the real light radiance
that  was focused by the lens on the image sensor when the scene was photographed. This  method
requires proper Exposure Values set for the particular photos in the sequence.

When the HDR generation window is opened the program reads the appropriate exposure time,
ISO and f-number values from JPEG, TIFF or RAW EXIF headers and utilizes them to calculate the
true EV (Exposure Value). If there is no EXIF data embedded in the files, the photos are sorted from the
darkest to the brightest and the Exposure Values are set up to meet the spacing requirement. You can
also edit each of the EV independently. Note that these values are critical in HDR calculation process,
especially when you want to receive a realistic result. Learn more about the Exposure Value.
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There are a couple of options available only for this algorithm:

● Selectivity:  Controls  what  parts  of  the  input  photos  and  with  what  weight  are  taken  into
consideration  during  the  HDR  image  creation  process.  The  “none”  setting  means  that  the
importance of all pixels is equal. The “balanced” setting means smaller weight for under- and
over-exposures (weight gets smaller symmetrically towards black and white). “Cut off over and
under  exposures”  disregards  just  the  worst  pixels,  while  “get  best  exposed” favors  brighter
pixels, where signal to noise ratio is higher, rather than darker pixels.

● Ghost removal: See below.

● Saving the HDR image: Check this option and choose the directory, the file name and format
(Radiance RGBE or OpenEXR). Saving the HDR image is possible only at this step.

Ghost removal

When the photos are well aligned some of the objects within the photographed scene may still
not match. These objects appear as ghosts in the final HDR image, because they are not in the same
position in all of the photos in a HDR sequence. In the “ghosted” area the input data for HDR image
calculation is improper and therefore has to be somehow fixed, otherwise ugly artifacts appear on the
final image.

A sample sequence of two differently exposed photos, where some subjects moved while the photos were taken.

Most common ghost sources are:
● moving people, cars, etc.,
● leaves or branches moving in the wind,
● fast moving clouds, smoke,
● ripples and waves on water,
● bad photo alignment,
● misalignment that cannot be removed by aligning the photos – i.e. due to parallax.

Normally it should be avoided to take HDR sequences of scenes where ghosts might appear, but
it would severely limit usability of HDR techniques. Ghost removal tool in easyHDR allows to create
HDR photos even if some of the image area is ghosted. There is a manual as well as automatic ghost
removal possibility.
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Automatic anti-ghosting may work well in some simple cases, when the ghosts are small and
weak.  However,  some areas might  be incorrectly  detected as  ghosted,  while some real  ghosts  may
remain undetected.

Manual anti-ghosting tool gives full control over ghost removal. The user is supposed to paint
a mask that marks the ghosted areas. Those marked parts of the photo are not HDR anymore and only
one input photo from the sequence is used to fill (patch) the hole. It is possible to select which input
image is to be used in the particular marked area. Selection of each target image is shown as a mask in
different color.

Manual ghost removal tool in the “Mask edit mode”. The mask has already been painted – red for 
0 EV photo (currently selected mask type) and cyan for the other, 1.58 EV photo. Longer exposure (cyan) 

is taken for the shadowed area, while the shorter exposure (red) is for the highlights.

The mask painting  tool  is  either  a  brush of various sizes  or a  flood-fill  tool.  The user can
explicitly select which input photo to use for the particular mask that is being painted. It is also possible
to leave the decision to the program and use the “Automatic” mask type (default). Mask type: “Eraser”
is of course for clearing already painted masks. Eraser is also enabled when painting with  Ctrl key
pressed. The flood-fill tool can be used to change the particular mask's target image, or to completely
erase the selected, individual masked area. It cannot flood-fill a not masked part of the photo.

As it was already mentioned before, the masked area is no longer a real HDR. It's just a well
calibrated patch of a single input photo. It means that the best results can be achieved when the ghosts
are relatively small and when the image that is selected for patching is well exposed (in the masked
area). Underexposed patch means high level of noise and possibly some brightness mismatch. In case of
overexposed patch the area will be overexposed in the final HDR image and additionally it will not
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match  in  brightness  (will  be  darker).  The  overexposed  and  underexposed  areas  are  repaired  when
“Repair  over  and  underexposed”  option  is  checked.  It  is  done  always  in  case  of  automatic  ghost
removal.

The mask should always be a bit larger than the ghosted area itself. The mask is automatically
smoothed to ensure better blending.

The calibration of input photos is crucial for matching the patches to the HDR image. Therefore
it  is  very  important  to  provide  valid  EV values  in  the  "HDR generation  window".  EV values  are
calculated automatically upon the EXIF data, so if EXIF headers are available in the input photos there
is no problem about that.

Tone mapped HDR image before (a) and after (b) manual ghost removal.

In the manual ghost removal tool there are several previewing options. By default the “Mask
edit mode” is selected, when the ghosted image with mask painted on it is visible. In order to show the
ghosted image without mask select the “HDR before deghosting” mode. Preview of image after ghost
removal is shown in the “HDR after deghosting” mode. When the mask type is selected as a particular
input photo, the “eye” button can be used to show this image. It can be useful while painting the mask to
select the desired image for patching.

The preview shows a HDR image that is not tone mapped with any local operator. It is actually
an artificial exposure of a generated HDR radiance map. By default it is exposed at 0 EV (relative to EV
values of the input photos). You can change the "exposure" to better show over or under exposures.
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a), b) and c) Input photos (-2, 0 and +2 EV) – differently exposed, people moved while the sequence was taken,
d) tone mapped HDR – no ghost removal, e) ghosts removed, but in a way to leave the people as in the 0 EV shot (see
the red mask), f) the ghosted areas were patched in a way to completely remove the people (red mask replaces ghosts

with part of a 0 EV photo, while the green mask patches the area with +2 EV photo).

The ghost removal tool can be used to repair ghosted areas in your HDR photo, but because it is
possible to select which photo should be used for patching, there is yet another and very interesting
possibility. It can be used to completely remove i.e. moving people or cars from a photograph. It's just a
matter of taking photos correctly. The ghost can be removed completely only if the affected area is well
exposed and without the moving object itself at least in one of the photos in a sequence (see the example
above).
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 3.3.2.2. Smart Merge

This method doesn't  generate  a  real  HDR radiance map.  Instead,  the input  photographs  are
merged together by taking the best exposed details with higher weight. The over and under exposed
areas are rejected. Ghost removal is not available here because the photos are not calibrated as it is done
for the True-HDR method.

The user can control the strength of Smart Merge's selectivity. In most cases the low values (0 –
2) are just perfect.  In case of some photo sequences stronger effect may give some further dynamic
range compression, but sometimes it may cause unnatural look.

The result of the merge may look very natural when only slight local contrast enhancement is
used. Of course stronger tone mapping may also be applied in order to get more dramatic look.

a), b) and c) Differently exposed photos (photo sequence loaded to easyHDR), 
d) Result after Smart Merge, strength = 1, e) Result after Smart Merge, strength = 5 

(both results processed with default tone mapping settings).

 3.3.2.3. Image Stacking

Stacking is a method of blending photos by simply taking the average of the input images. The
luminance value for each pixel is a sum of the true signal and of course the noise. If the photographed
scene is static, the signal acquired for each pixel is constant for each photo taken at the same exposure
settings, while the noise is random. The average of the noise aims for a constant bias and thus is easy to
subtract by a slight contrast boost. In other words by taking an average of photos the signal to noise ratio

23/52

http://www.easyhdr.com/


        easyHDR 3.2 http://www.easyhdr.com/

(SNR) is increased. Also the dynamic range is expanded given the image quality improvement for the
darkest areas.

The following example shows the comparison between a single, enhanced (LDR enhancement)
photo and a stack of 5 photos that was processed with easyHDR. You can see the dramatic decrease of
noise. The 5 photos were taken with Canon 350D at exactly the same exposure settings (25 seconds,
ISO400, f-number: 3.5).

You can also try to stack differently exposed photos instead of generating a HDR image. The
result will be characterized by improved dynamic range, but cannot be called a High Dynamic Range
radiance  map,  because  the  input  photos  are  not  calibrated  and  the  luminance  scale  is  untrue.
Nevertheless the result may be pleasing in some cases.

24/52

http://www.easyhdr.com/


        easyHDR 3.2 http://www.easyhdr.com/

4. Tone mapping 

When the HDR radiance map is generated, the next step is to tone map it, so it can be displayed
on  the  computer  screen,  saved  in  a  typical  image  format  or  printed.  Thanks  to  tone  mapping  the
dynamic range of the photographed scene is preserved and fitted into the capabilities of display media
(or storage formats). The resulting photo is in fact LDR (Low Dynamic Range), but it contains details
present in the whole dynamic range of the photographed scene. Therefore it is wrong to call the result a
HDR or either LDR image. It should be called a  tone mapped HDR radiance map. Tone mapping
does not only apply to the processing of HDR images. A digital camera applies tone mapping (with a
global operator - in this case a simple curve compression) in order to fit the acquired (i.e.) 12-bit image
pixel data into 8-bit per pixel (per channel) picture format. 

When the HDR image is generated in easyHDR the preview size is automatically adjusted so the
previewing process does not take too much time. After finding the best tone mapping settings just click
the “Process all” button.

EasyHDR allows you to save and load tone mapping settings.  It  also has a preset selection
feature, which allows faster access to most commonly used settings. To find out more about settings and
presets please go to paragraph 7.

 4.1. Global vs. local operator

There are 3 operator functions from which to choose. If the “Local contrast” and “Mask” check-
boxes are unchecked only the global operator is being applied. By checking the aforementioned options
the 2 available local operators can be enabled.

The global operator works the same for all pixels in the processed image, regardless on their
position. The result for each pixel is computed by using only the operator parameters set by the user and
the pixel's value. This ensures that there will be no brightness inversions in the output photo, leaving it
as  natural  as  it  is  possible,  while  fitting  the  selected  scene  dynamic  range  into  the  display  media
capabilities. No brightness inversions mean that the areas that were brighter than others in the real,
photographed scene, will remain brighter. This limitation makes it very difficult to compress the entire
dynamic range, without washing out colors or loosing local contrast. 

The local operator, on the other hand, is spatially variable. The local parameters are computed
for  each  pixel  independently  while  taking  its  neighboring  pixels  into  account.  Therefore  the  local
operator  is  capable  of  greater  contrast  reduction  on  wide  scale,  at  the  same  time  preserving  local
contrasts (details) and colors. When the effect is too strong, however, the photo may become unnatural.
It may sometimes be anticipated – to achieve a dramatic result, but also sometimes an unwanted “halo
effect” can show up.

The local operator works similarly to local, chemical adaptation in the human eye, which is one
of the factors that make the human vision capable of sensing very wide dynamic range. Note that in
classical digital photography only the global operators are used (i.e. gamma pre-processing inside a
digital camera).
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The parameters for the global operator in easyHDR are: 

● Compression, 

● Gamma,

● Contrast (histogram clipping),

● Color adjustment and color saturation (hue, white 
balance and selective saturation), 

● Tone curve (L, R, G and B channels). 

for the "Local Contrast": 

● Strength, 

● Highlights,

● Shadows,

● Blackness,

● Range,

● Micro.

and for the "Mask" local operator: 

● Strength.

 4.2. Global Operator: Compression, Gamma & Saturation

Gamma curve adjust is a function available in most image editing software.  It brightens or
darkens the photo, but at the same time it does not cause any image data to be lost, by clipping the pixel
values to black or white.  It  applies a non-linear (gamma curve) transformation that compresses the
whole dynamic range of the processed photo. When the value is higher than 1.00 the pixel luminance in
shadows is amplified more than in the bright areas, therefore the compression is achieved. Setting the
values below 1.00 makes the photo darker and also the contrast gets stronger.

The  “Compression” function  applies  a  similar  non-linear  transformation  as  gamma adjust.
However as opposed to the gamma function, it preserves and even increases the color saturation. See the
example below. 

Both parameters should be used together in order to get best results. In example, if the photo
gets too bright after the “Compression” is increased, it can be darkened with the “gamma” setting.
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a) Photo tone mapped with default settings (Gamma = 1.00, Compression = 1.00), b) Gamma = 1.80, 
c) Compression = 2.20, d) Gamma = 0.80, Compression = 2.20.

 4.3. Global Operator: Tone curve

Tone curve adjust is a powerful, but simple in use tool that is implemented in almost every
image editing software. It offers much more flexibility than the gamma setting described above. The
user manually shapes, using special knee points, the curve that is used to compress the dynamic range of
the photo. The points can be created by simply clicking in the curve area with the left mouse button.
Knee point removal is done by pressing the right mouse button while the cursor hovers over the selected
point. 
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The  curve  tool  that  is  implemented  in  easyHDR operates  on  HDR rather  than  LDR (Low
Dynamic Range) image data, as it is done in typical photo editing software. Because of that, operations
can have different, much better effects, i.e. brightening shadows does not necessarily mean boosting
noise level (of course there must be enough shadow information in the HDR composite). 

The curve tool does not make any changes to the output image when it is in the reset position
(straight line). It gives enough flexibility when there are 2 or 3 knee points.

EasyHDR allows editing curve either for  pixel  luminance or for each (red,  green and blue)
channels separately. There is a set of several ready to use presets that can be the starting points to further
curve shaping – to access them just press the “star” button.

 4.4. Local Operator: Mask

The "Mask" operator works similarly to a gray filter mounted in front of CCD or CMOS device
during the exposure. The light coming from the photographed scene is focused on the surface of the
imaging sensor, but the filter attenuates it in certain regions more than in the other. The idea is similar to
using a gradient, gray filter mounted in front of the camera lens.

In case of HDR image processing, the High Dynamic Range radiance map that is recovered
from a sequence of photos is the estimated irradiation of the surface of the imaging sensor during the
exposure. EasyHDR calculates the complex gray filter mask based on the input HDR image and applies
the attenuation. The brighter, large-scale areas are attenuated stronger, than the shadows. Since the mask
does not affect the small-scale luminance variations, the local contrasts (details) are preserved – they are
not flattened.

A linear gradient gray filter may be enough in case of the simple scene as shown here. The two photos 
on the left are real single shots of the same scene taken with different exposure times. On the right side 

there is a simulated view as if the photo was taken with a gradient, gray filter. 

The strength of the mask operator is controlled with the "Strength" parameter. Higher values
mean stronger attenuation of the bright areas, while the darker areas are more strongly intensified.
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In case of both photos: gamma = 1.00, compression = 1.80.
a) Strength = 0.00, b) Strength = 0.40.

 4.5. Local Operator: Local Contrast

This  operator  compresses  the  global  dynamic  range of  the  photograph while  enhancing  the
details at local level. It gives a lot of possibilities ranging from just slight improvement of contrasts (to
give  better  realism)  up  to  achieving  very  dramatic  results.  The  “local  contrast”  operator  is  very
sensitive, so when used with strong settings it may amplify noise, especially if the input images are of
low quality (i.e. taken with high ISO, with a poor digital camera, or saved with high JPEG compression
settings). In case of processing HDR image sequences please keep in mind that the noise level might be
lower if the HDR sequence of images covers the entire dynamic range of the scene – so if there are no
parts of the scene that are not properly exposed in any of the photos. Noise reduction is also achieved by
using “normal” selectivity in case of the True-HDR method. Even lower noise level should be possible
when using the Smart Merge method.

a) No local contrast applied, b) Local contrast applied 
By using the “local contrast” operator we achieve greater compression of the dynamic range of the 

photograph, while the details are not only preserved... they are enhanced.

The "Local Contrast" operator is controlled by a number of parameters. The "Strength" defines
the power of dynamic range compression and local contrast boost. The “Range” controls the extent of
the local detail sensing. The higher is the value the bigger areas of the photo are being treated as “local”.
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There is also a pair of parameters that control the brightness- and darkness- sensing thresholds of
the operator. The “Highlights” setting defines how strong should be the contrast enhancement in the
brightest parts of the photograph. At the same time it little affects the darkest parts. The “Shadows” on
the other hand controls the level of dynamic range reduction in the dark areas. 

a) Strength = 0,50, highlights = 0.00, shadows = 0.30, b) Strength = 0.50, highlights = 0.60, shadows = 0.10.
By increasing the “highlights” parameter the clouds (which are the brightest in this photo) get more dramatic, 

while by decreasing the “shadows” setting the darkest areas are more strongly amplified.

If the signal to noise ratio in the darkest parts of the photograph (i.e. deep shadows or dark, night
sky) is too small, then it might be desirable not to enhance those parts so much because otherwise the
noise level would be unacceptable. Not enhancing the shadows too strongly could also preserve the feel
of realism. In order to achieve that please try increasing the “Shadows” value as well as “Blackness”,
which controls the threshold of shadow deepness. 

a) Blackness = 0,30, b) Blackness = 0,60.

There  is  also  an  additional  parameter:  “Micro”.  It  controls  strength  of  the  smallest  detail
enhancement. By using it it is possible to make the photo a bit sharper.

By using the “Mask” operator in combination with the “Local contrast” it is possible to further
boost brightness in the shadows and to attenuate the brightest parts of the image, while not bringing up
noise so much as it could be happening with the “local contrast” alone .
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 4.6. Black & white clip (contrast)

The human eye is not able to "see" the whole dynamic range of every scene, so if you want to
achieve a natural effect it is sometimes good to clip some shadows to black and some bright areas to
white. By loosing some information in those areas you get better a looking, more natural image with
better contrast. By default 0.1% of the darkest pixels are cut to black and the 0.2% of the brightest are
clipped to white. This makes the result look much more natural and not washed out, while sacrificing
only a small fraction of the dynamic range.

To set the clipping points just move the markers over the histogram or manually set the desired
cut-off pixel percentage, for black and white separately. There is also a possibility to set the clipping
points  by sampling the image with eyedropper  tools.  In  order to  use  the eyedroppers  click  on the
appropriate icon and then select the desired point on the image. Using left mouse button selects the point
from the currently viewed result image, while using the right mouse button chooses the point from the
input HDR image.

If the padlock icon is "locked", the clipping is done automatically to the preset percentage values
when other tone mapping parameters are changed. When it is in the “unlocked”  position, the markers
always stay in the same place, but you can still move them manually. 

31/52

http://www.easyhdr.com/


        easyHDR 3.2 http://www.easyhdr.com/

Example of the histogram clipping. The entire available dynamic range is preserved in the photo a), while in case 
of photo b) the 4,7% of darkest pixels are clipped to black and 1,8% of the brightest pixels are clipped 

to white. This means that there is a loss in dynamic range, but at the same time the photo has higher contrast. 

You can mark the overexposed (red) and underexposed (blue) areas to see how much detail is
not available (was not recorded on any photo from the HDR sequence) or is lost due to clipping.

Click on the histogram to toggle the mode –  right mouse button switches between RGB and
Luminance mode, while the left mouse button selects linear or logarithmic Y-axis.

32/52

http://www.easyhdr.com/


        easyHDR 3.2 http://www.easyhdr.com/

 4.7. Color saturation

EasyHDR allows advanced control over color saturation. There is not only global saturation
setting, but there are also two selective tools:

● saturation selective by brightness,

● saturation selective by hue.

The small circles mark the currently pointed pixel on the brightness and the hue axes. The status bar 
shows the pixel value under the cursor.

The horizontal axes have the meaning of brightness and hue respectively. When the curve is in
the middle of the gradient field (as depicted above), the saturation is not altered. Moving the curve up
means boosting saturation for the selected types of pixels, while lowering the curve means selective
decrease of saturation.

a) Saturation settings at reset position, b) Increased saturation for the blue color.
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The user has control over the shape of the curve by the mean of control points. Each of them
defines a separate Gaussian function for which it is possible to set sigma (smoothness) parameter. If the
separate curves are close enough to each other, they are glued together, so it is possible to draw straight
lines. In order to add a new control point just click with the left mouse button on the tool. To remove a
point use the right mouse button.

One of the more advanced possibilities that the selective saturation gives is leaving just a single
color tone and making the rest of the photograph black and white. 

Saturation has been reduced to zero for all colors apart from red and violet.

 4.8. Color adjustment

The  camera  not  always  uses  the  perfect  white  balance  settings  when  the  photos  are  taken.
EasyHDR allows you to fix  the color tone at the tone mapping step. Two settings fulfill  this task:
“Temperature” and “Tint”.  The first controls the blue-orange tone, while the second of them allows
green-magenta balance.

If there is a spot on the photo that should be neutral you can sample it with the eyedropper tool.
EasyHDR will set the temperature and tint to fulfill the requirement. 
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a) Tone mapped HDR created out of 5 photos that had some bluish tint due to bad white 
balancing done by the camera, b) white balance corrected automatically by sampling the marked spot.

The “Hue” setting, when used very delicately, can help with achieving best color temperature
correction. When tweaked more strongly it creates unreal effects by shifting the colors.

5. Post processing

If you are finished with tone mapping, you may do some post processing to the output image
before you save it. You can use 4 filters: Gaussian blur, sharpen, median and bilateral filter. EasyHDR
also allows manipulation of color tones and cropping.

After filtering is applied, it is possible to undo (in all cases excluding cropping). If you want to
reset all applied post processing you can simply go back to tone mapping step and reprocess the whole
image.

 5.1. Gaussian blur (smoothing)

You can use Gaussian blur filter to introduce some neat smoothing effect to your photo. The
higher the "Sigma" value the more blurred is the result. Use the "Opacity" setting to mix the blurred
result with the input.
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a) Input photo: 8MPix, b) Sigma = 6.0, opacity = 100%, c) Sigma = 6.0, opacity = 50%.

 5.2. Unsharp mask (sharpening)

The sharpening tool is a must in every image editing software. EasyHDR allows sharpening at
the tone mapping level, but also in the post processing step. You can change three parameters: "Sigma"
– extent; "Amount" – strength of the effect; "Threshold" – cutoff level.

a) Input photo, b) Sigma = 1.0, amount = 100%, threshold = 0.00, 
c) Sigma = 3.0, amount = 100%, threshold = 0.05.
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 5.3. Median filter (noise reduction)

If you want to remove salt & pepper noise like hot pixels and you don't have a dark frame, this
filter will be just what you need. It scans the masked neighborhood of each pixel and exchanges the
luminance of the pixel with the computed, median (most probable) value. You can set the matching
threshold, so only pixels that are significantly different than their neighbors are affected. It causes the
noise to be wiped out while the other areas of the photo are left unchanged.

a) Input photo – Orion nebula, b) some dark bad pixels are easily removed with the median filter. 
Threshold: 0.12, horizontal bar – 5 pixels.

 5.4. Bilateral filter (noise reduction)

The bilateral filter is a great noise removal tool that blurs noise while preserving edges. The
example below shows how the filter works. The low-scale areas similar in luminance are blurred, while
the significant edges are not affected.

Apart from "Opacity", the user can control "Sigma" – extent of blurring and "Threshold" –
edge detection level.
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a) Input photo, b) Sigma = 2.0, opacity = 100%, threshold = 0.5, 
c)  Sigma = 4.0, opacity = 100%, threshold = 1.0.

 5.5. Sample/target balance

This tool allows to change sampled color tones into target colors (set by the user). For greater
flexibility you can apply changes to shadows, highlights or middle tones separately. Additionally you
can limit the strength of the color transformation by lowering the "Opacity".
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You can set the target color by clicking the left mouse button on the appropriate field. Click on
the sample to reset the target color. If the target color is the same as sample the tool has no effect.

 5.6. Image transformations

The image transformations can be done at any step – right after images are loaded, during tone
mapping or post-processing. It is possible to rotate the photo by 90° left, or right, rotate by 180°  and flip
it horizontally and vertically.  There is also a combined – crop and free rotate function.

Cropping the image.

When  in  cropping  mode,  an additional bar with options is shown. The cropping area size and image
rotation angle is displayed and can be modified. There is also an option to show vertical and horizontal
guidelines,  that  are useful  while rotating the image. Finally,  there are buttons allowing to apply or
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cancel the transformation. The best way to mark the cropping area is to just use the mouse. The whole
selection can be easily displaced with mouse button pressed. Clicking away of the area means starting a
new selection.  Moving the  mouse while  pressing  left  button  and  Shift key  down allows free-hand
rotation. Double clicking on cropped area applies the transformation, while pressing Esc key cancels it.

Note: it is not possible to undo the cropping and free rotation. Please use it
with caution!  Please also note, that applying free rotation several times
causes  tiny  degradation  of  image  details.  It's  because  of  anti-aliasing
filtering applied. For best quality you should preview rotation carefully
and apply it just once.

6. Color management

EasyHDR  can  properly  work  with  color  managed  photos  and  monitor  profiles.  The  Color
Management is disabled by default (when the program is installed), but can be enabled by checking the
option in the main menu: Color Settings → Color Management.

Color Management options – in the main menu as well as the status bar.

The photograph's color space is extracted automatically from the JPEG or TIFF input once the
image file is loaded. In case of RAWs, RadianceRGBE and OpenEXR the color space is user-defined at
loading. If the color space definition is not embedded it is always possible to manually select the space
from a list (sRGB, AdobeRGB, WideGamut or ProPhoto). The monitor color profile can be selected
from one of standard profiles (sRGB, AdobeRGB, AppleRGB or ColorMatch) or loaded from a ICC or
ICM file.

The color transform function that is calculated basing on the input and output profiles is used to
properly display the image colors in the program's preview window. The color space of the output photo
is not changed and is the same as it is in case of the inputs. The color space definition is just rewritten to
the output photo, so other color management aware software can display it properly.

Raw photos, by definition, do not have any color space. When they are loaded, the image data is
decoded into a user-defined RGB color space. 
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EasyHDR can work  only with  RGB color  spaces.  Other,  like  for  example:  CMYK are  not
possible to use. Note that all input photos (that are used to create one HDR image) have to be in the
same color space, otherwise easyHDR will deny to load them.

For best quality process only 16-bit, color managed TIFFs.

7. Batch processing

If  you want  to  process many image sequences,  especially  if  the photos are  very big,  you'll
appreciate the advantages of batch processing. The idea is to create a list of many tasks to be done by
easyHDR and then let the program do the whole job without user  interaction. Below you can see the
batch processing window (click File → Batch processing).

The main batch processing configuration window.
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The first step is to create a list of tasks (1). To do so use “Auto create tasks” option to make tasks
automatically out of files from within a defined directory. There is also a possibility to add a single task
by directly pointing a HDR image sequence (or a single image for LDR enhancement). 

The tasks (2) are displayed in a scroll box. Each of them is a separate processing job for easyHDR and
has own settings associated (3). Every task has a name that is used as the output file name. The input
photos' names are also displayed along with the thumbnails. To change the task name simply click on it.
The settings are displayed for all selected tasks. If at least one of them has different settings, a warning
message is shown:

You can apply then the currently visible settings to all selected tasks. 

If there are various types of tasks selected at once (both HDR sequences and single photos) always the
settings for HDR processing are displayed. Of course some of the options are not valid for single-photo
tasks  in  this  case.  If  tasks  consisting  of  only  single  photos  are  selected,  then  appropriate  set  of
parameters is visible, as depicted in the picture below.

Settings for single-photo tasks.

There are three possible options for tone mapping settings usage. You can select any settings file
(*.ehsx) from your hard drive, you can choose a single preset from drop down list, or finally, you can
select a set of available presets. In the latter case, tasks are processed several times, for each selected
settings. The preset name is appended to the output file name. This option is perfect if you want to
compare results achieved with several settings and just choose those which you prefer.

The task list can be saved and loaded later. There is an option to process only tasks that were not
completed previously, so it's possible to continue the once stopped job, even after system restart. It's just
important not to change the input photos location on the disk and not to delete or remove the already
done results.
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Configuration common for the whole batch job is available after switching to the “Options” tab (4). 

Options common to the whole batch job.

The options are: 

● Color space for the imported RAW and HDR images,

● Destination folder – by default each task is saved in the same folder as the input photos, but it
can be a different, user specified location,

● Result file format – JPEG or TIFF,

● Option to skip the already completed tasks – see the note above in this paragraph.

When everything is ready, you can finally start the batch job. It's possible to run all the tasks, or just
those selected. There is also an option to shutdown the system on completion. When you use it, please
make sure that all of your open documents are saved, or better, that all other applications are
closed. This will prevent data loss.

 7.1. Automatic task list creation

The power of batch processing is handling tens or hundreds of tasks. It wouldn't make much
sense  if  tasks had  to  be  created  manually  one  by  one.  EasyHDR  is  able  to  create  the  task  list
automatically.

It is possible to add tasks built out of files from within a single directory. The current list is appended,
not  cleared  first,  so  this  feature  can  be  used  several  times  for  different  inputs.  By default  a  fully
automatic method of HDR image sequence detection is in effect. In this mode, the EXIF headers of all
the image files found in the defined directory are examined by easyHDR. The photos that were taken
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within a very short period of time are assumed to be in a single HDR sequence. If you always take your
HDR sequences using AEB mode in your camera, you should also select “AEB sequences only” option.
It raises the accuracy because photos taken in continuous shooting mode (but not AEB) or those taken
fast one after another are not merged together into single tasks.

Automatic task creation options.

Another method assumes a fixed amount of photos in each HDR sequence, in the source folder. There is
also a simple mode useful when you want to process single photos only (LDR enhancement). Each task
consists then out of a single photo.
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8. Tone mapping settings management, presets

EasyHDR allows you to save the tone mapping settings to files and to
import those settings later. The most commonly used settings can be put into
a special pool of presets. When the program is installed, a couple of built-in
presets are already there – i.e. “dramatic-bright” or “natural”. 

In  order  to  add  a  new,  user  preset  (based  on  the  currently  selected  tone
mapping settings) you can use the “plus” button in the top-right corner of the
panel.  You can rename user presets by simply clicking on the names. To
replace  a  preset  with  current  settings  or  delete  it,  just  click  right  mouse
button on the thumbnail to open a pop-up menu with options.

The presets are just ordinary easyHDR settings files (*.ehsx). What makes
them different is the place where they are stored:

● Win XP: C:\Documents and Settings\[name]\easyHDR 3\presets\,

● Windows 7: C:\Users\[name]\easyHDR 3\presets\,

● OS X: /Users/[name]/Documents/easyHDR3/presets.

The built-in presets are in the easyHDR appliaction folder:

● Windows: C:\Program Files\easyHDR 3\built-in presets, 

● OS X: symbolic link - /Users/[name]/Documents/easyHDR3/built-in
presets.

The user presets can be grouped into user-defined
folders. Group selection is possible only when user presets
are  filtered  (third  button  from  the  left).  To  move  an
existing preset from one group to another just right click
on it and choose the target.

Management is done with:  Settings  → Setup user preset
groups.  Using the dialog, you can  create or remove the
groups. Renaming is possible after double clicking on an
existing  group  name.  When  removing  a  group  that
contains presets you can choose either to delete, or to keep
them as “not grouped”.

The user groups are just sub-folders  in the  easyHDR 3/
presets location on your hard disk, which means it's very
easy to manage all the user presets manually using Explorer (Windows) or Finder (Mac). Please note
however, that after manipulating files and folders there, you have to restart easyHDR, so it can refresh
it's own lists. The simplicity of user preset handling adds another advantage -  you can easily back up or
move your presets from one PC to another, or even share them with other people.
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9. Saving the result

EasyHDR can save the results in TIFF and JPEG image formats. It is also possible to save the
generated HDR radiance map as Radiance RGBE (*.hdr) or OpenEXR (*.exr).  However it  is  only
allowed in the "HDR generation" window, for the True-HDR method.

The difference between TIFF and JPEG format is that the first of them is loss-less (even if the data is
compressed). It means that absolutely no detail is lost when the file is saved. The  LZW compression
works well with 8-bit TIFFs, but for 16-bit data  the  Deflate method produces, in most cases, smaller
files. For best quality you should save in 16-bit TIFF format,  especially if you want to do further post
processing with other photo editing tools.

When saving in JPEG format it is additionally possible to resize the photo. You can define the size in
pixels manually. The aspect ratio is locked. 

EasyHDR is capable of transferring EXIF headers to the output photographs. It uses an external
Exiftool software to achieve this goal. Exiftool is capable of transferring full EXIF data from and to all
image formats  including RAW photos.  If your camera stores location information,  but you want to
remove it from the particular photograph, you may easily do so by unchecking the GPS box. It's perfect
option if you want to share the photos on the Internet, but you don't want to show everybody the exact
location where they were taken (eg. in your backyard).

When color management is enabled, it is possible to convert the color space of the photo to sRGB. It is
useful if photos in other color space were processed and you want the results to be displayed correctly
by programs that do not support color management, also when you want to publish them on a web page.

The DPI value definition is for user's convenience. It does not influence the pixel dimensions, or amount
of detail. It is just a value that in addition to pixel dimensions defines the physical dimensions of the
photo. It is useful to set it to a value that you normally use when preparing for printing, because then
you can more easily edit the physical dimensions of the photo when post-processing in an external
application.  The  most  commonly  used  value  is  300,  it  ensures  very  good  print  quality  (invisible
pixelisation).

Physical dimension [mm]=
Pixel dimension

DPI
⋅25.4

Pixel dimension=
Physical dimension[mm]⋅DPI

25.4
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In case of DPI  resolution =  300, the pixel dimensions for a 15x10 cm print  are:  1772 x 1181 (just 2
megapixels). An 18 megapixel photo can be printed on a ca. 44 x 29 cm paper.

 9.1. Exporting to external editor

If you want to do further processing on the photo generated with easyHDR  you can use the
export to external editor option instead of saving to file and manually opening it with the other software.
Before this option can be used it must be configured in the Program Options. You have to provide a path
to executable of the third party software you want to use.

Configuration of the external editor.

Export to external editor allows transfer of 8 or 16 bit pixel format. It is user selectable, because not all
image editing software support 16 bit photos. It is also possible to select whether conversion to sRGB is
needed, or the color space should remain the same.

10. Program options

Most of the program settings are saved automatically when the program is closed (eg. image
saving options).  There are several  options  however  that  are  set manually.  In order to  modify these
settings click Settings → Program options. 
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Scratch pad memory

You can choose here which hard drive (or directory) should be used by easyHDR to store temporary
data. The option is set to system temporary directory by default. This setting should be modified only if
you have little free space on the hard drive where the operating system is installed. The necessary free
space for the program to work properly depends on how big images you want to load into the program
and how many of them are in sequences you blend into HDR. The data is dumped to the disk only if it
cannot be stored in memory. It's good to have at least 1 GB of free space.

Performance

EasyHDR is capable of using several CPU cores, if they are available. By doing parallel processing the
performance of the program is greatly improved. It is possible to select the maximal number of cores
used by the program in normal or in the batch mode separately. Note that when the maximal number of
cores to be used is the same as available number of cores, easyHDR will claim 100% of CPU time
during some operations. That means that other processes running on your system will work much slower
during that period of time. 

There are also other performance settings. When live anti-aliasing is enabled the photos are anti-aliased
while zooming and panning, otherwise a rough image is displayed and after  some timeout an anti-
aliased view appears. The live tone mapping mode means that the tone mapping preview is generated at
the same time as the settings change, otherwise a timeout must pass before the view is refreshed. Live
tone mapping while zooming and panning does not require any further explanation.

Saving result 

Here it is possible to define the default  suffixes added to the output photos in both: normal and batch
mode.  You can also choose whether the output folder shall be the same as the folder of the source
photos, or shall it be as the last that was used for saving.

Other saving parameters are stored automatically when program is closed.
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Miscellaneous

Some other options are available here:

● Reset color adjustment settings for new project

When enabled, the Color Adjustment settings (temperature and tint) are reset for new projects.

● Automatically show file open dialog when starting new project

It is enabled by default. Disabling it is useful when you want to load photos mostly by dropping
them on the workspace instead of using the “New” or “Add” buttons.

● Apply LDR enhancement automatically when only one photo is loaded

When this option is enabled the program doesn't show the LDR enhancement dialog when a
single photo is loaded, instead it immediately goes to tone mapping. The last used settings are
assumed (noise filtering on/off and its parameters).

● Require Ctrl/Cmd key pressed to zoom with mouse wheel

By default this option is turned off. In this case zooming the image can be done  with mouse
wheel. When it's on, mouse wheel is used to scroll the image (up/down and left/right), zooming
requires  Ctrl (Windows), or Cmd (Mac OS) key to be held. 

11. Adobe Lightroom plug-in

The plug-in allows exporting photos from Adobe Lightroom (version 3 and higher) to easyHDR.
After  processing,  the results are automatically imported into the Lightroom Catalog. There are two
modes of operation: 

● Export for manual editing with easyHDR,

● Automatic processing with easyHDR running in background, using user-defined settings.

Installation and setup

Install easyHDR 3 demo if you want to try,  or the full  version if you are a registered user.
During installation please make sure that Lightroom plug-in option is selected. It is selected by default if
Lightroom is detected in the system.

The plug-in installs in:  C:\Users\[name]\AppData\Roaming\Adobe\Lightroom\Modules\ on Windows,
or in /Users/[name]/Library/Application Support/Adobe/Lightroom/Modules on OS X. It automatically
becomes available to Lightroom, you may just need to enable it in the "Plug-in manager".
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In Lightroom, go to File → Export and define your custom Lightroom export presets (it's optional, but
useful). The locations of easyHDR's tone mapping presets: 

● Windows:  C:\Program Files\easyHDR 3\built-in  presets and  for  the  user  presets:  C:\Users\
[name]\easyHDR 3\presets. 

● OS X:  /Users/[name]/Documents/easyHDR3/built-in presets  and for the user presets:  /Users/
[name]/Documents/easyHDR3/presets.
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Using the plug-in

1. Make sure that the option to show "All Photographs"  is chosen. Mark the sequence of photos
you want to merge, or a single photo to process.

2. Export by  selecting File  →  Export,  use a previously defined preset as available in  File  →
Export with preset, or choose an export option from the context menu.
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3. EasyHDR starts  and does processing automatically or allows manual  editing – as was your
choice of the mode of operation. If you chose manual processing, you have to save the result to
file and then close easyHDR. The result is imported into the Catalog.
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